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cumulative P loss to Minnesota’s waters. 
Other fields are significant individual sources 
of P loss. This publication describes how to 
estimate P loss risk for individual fields and 
identify site-specific management practices that 
are likely to reduce risk. 

The MN P Index and Other 
Assessment Tools
Direct measurements of P loss are rarely 
practical. Instead, models or indicators 
are used to estimate current or future P 
losses under various management scenarios 
(Table 1). Because models are mathematical 
representations of systems, the quality of an 

The Phosphorus Challenge
Minnesota lakes and streams are a key part of 
the state’s economy and quality of life. When 
excess phosphorus (P) gets into surface water, 
recreational uses and aquatic life are impacted. 
The excess P causes increased algae growth. 
In turn, there is less clear water, lower oxygen 
content, and shading of aquatic plants that are 
habitat and food for fish and water fowl. 

Excess P may come from many sources 
including municipal and industrial waste, urban 
runoff, septic systems, wind-eroded sediments, 
stream bank erosion, and runoff from feedlots 
and agricultural fields. This publication only 
considers runoff from agricultural fields. 

Phosphorus is essential for crop production but 
can be lost to runoff from soil, plant residue, 
and surface-applied fertilizer and manure. The 
challenge is to keep phosphorus on the land 
and out of the water.

Many farm fields are not significant sources 
of P by themselves but contribute to the 

Excess phosphorus in surface water reduces 
water quality for many uses.

Table 1: Phosphorus Loss Assessment Tools

 
NRCS 590 standards 

and MPCA 7020 rules*
Rapid P Index MN P Index

Type Indicators and practices Indicators Mechanistic model of three pathways

Uses
To control major P loss 
risk factors related to 
manure application

To reduce the number of sites 
where the MN P Index will be 
applied

Farm nutrient management planning, 
and watershed planning to control P loss

Inputs

Distance to water,  
Soil test P,  
Erosion,  
Filter strip, 
Manure method and  
   timing

Distance to water,  
Soil test P,  
Erosion,  
P fertilizer and manure rate  
   and method

Distance to water, 
Soil test P,  
Erosion, 
P fertilizer and manure rate and method, 
Tillage type and direction, 
County, 
Crop rotation

Output
Manure application rate 
restrictions

Indicates whether field is 
above or below risk threshold

Relative rating of risk of P loss

  *These are not primarily P loss assessment tools, but comprehensive feedlot and nutrient management guidelines.
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estimate depends on the quantity of inputs. 
Thus, a user must choose between models that 
are quick and easy to use but only generate 
crude estimates, and models that generate 
higher quality estimates but require far 
more time to learn and use. The models in 
Table 1 estimate risk of P loss. More elaborate 
models, such as the Agricultural Non-Point 
Source (AGNPS) model, will estimate actual 
P delivery. In any case, interpreting model 
outputs requires understanding the assumptions 
and research behind the model.   

The simplest method for preventing P loss is 
to apply the requirements in the Minnesota 
Pollution Control Agency (MPCA) Chapter 
7020 Feedlot Rules or the standards in the 
USDA Natural Resources Conservation Service 
(NRCS) 590 Nutrient Management Standard. 
These two documents provide comprehensive 
guidance for feedlot and nutrient management. 
They are not principally P loss assessment 
tools, but they include guidance aimed at 
preventing P loss and thus can be used to 
infer high risk situations. Manure application 
limits related to P loss are based on four to five 

indicators: erosion rates, soil test P, distance 
to water, presence of vegetated buffers, and 
method of application. 

The Minnesota Phosphorus Index (MN P 
Index) is a model with the primary purpose 
of estimating P loss risk. A computerized 
version of the model is available at 
http://www.mnpi.umn.edu. The MN P Index is 
used when a more accurate estimate is needed 
(e.g., on sites with multiple risk factors), or 
to estimate P loss risk unrelated to manure 
applications (e.g., to identify P loss sites within 
a watershed). The MN P Index helps users 
identify and refine site-specific methods to 
reduce P loss by considering the interaction 
of a wide range of risk factors including 
landscape characteristics, cropping and tillage 
practices, and P application methods. 

The MN P Index assesses P loss risk by 
modeling three major pathways of P movement 
from fields to water: erosion, rainfall runoff, 
and snowmelt runoff (Fig. 1). For each 
pathway a transport mechanism is multiplied 
by P sources to calculate a P loss risk for that 
pathway. The three pathways are summed 

Figure 1: The Minnesota Phosphorus Index Model

 

aThe erosion rate is the sediment delivery value from RUSLE2 (a soil erosion predictor), 
i.e., not gross soil loss but only the amount reaching the edge of the field. 

bOf the sediment leaving the field, the Sediment Delivery Ratio (SDR) is an estimate of the 
proportion that reaches surface water. The SDR is based on distance from field to water. 

cTotal soil P is estimated from soil test P and soil organic matter. 

P Sources: Transport Mechanism:  

Pathway 
1 

Pathway 
2 

Erosion Ratea X  
Sediment Delivery Ratiob  

Rainfall Runoff Rate 

Snowmelt Runoff Rate 

Total Soil Pc  

Soluble Soil P  
+ Applied P 

P in Plant Residue  
+ Winter Applied P  

X 

X 

X 

Overall risk of  
P loss 
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Risk of particulate P  

lost via erosion 

= 
Risk of soluble P  

lost via rainfall runoff 
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lost via snowmelt 
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to get a total P loss risk value. Usually one 
pathway plays a bigger role in overall P loss 
risk than others. Management changes that 
address that pathway will be the most effective 
method for reducing the overall risk. 

Phosphorus can travel by other pathways 
not considered by the MN P Index including 
leaching through the soil, which is generally a 
minor concern, and via wind or gully erosion, 
which can be significant concerns but are 
difficult to model at a field scale.

The MN P Index is a management decision-
making tool. The inputs are easily available 
and it generates results that are reliable for 
making farm-level decisions or for watershed 
planning. The output is an estimate of the 
relative risk of P loss from a farm field, not a 
quantitative estimate of P delivery. 

The strengths of the MN P Index are in 
comparing the level of risk between sites, 
determining how management practices affect 
P loss risk, and in assessing the interaction of 
risk factors that may not seem significant when 
considered alone. 

How to Assess P Loss Risk
The method of P loss risk assessment differs 
for a farm manager planning practices that do 
not threaten water quality, and for a watershed 
planner identifying and addressing sources of P 
to a lake or stream.

Farm manure and nutrient 
management

Planning the location, timing, and method of 
manure application should begin with state 
(MPCA) regulations outlined in Applying 
Manure in Sensitive Areas. This document is 
based on the MPCA Chapter 7020 Feedlot 
Rule and the NRCS 590 Nutrient Management 
Standard (See Resources). The MPCA rules 

pertain to anyone applying manure while 
NRCS standards are used by producers who are 
enrolled in NRCS-administered conservation 
programs and others who have requested 
nutrient management assistance. NRCS 
standards and MPCA rules consider nitrogen 
and pathogen concerns along with phosphorus. 

After using the MPCA rules and NRCS 
standards, the MN P Index may be used to give 
producers more flexibility in some situations. 
Specifically, at the largest category of livestock 
farms, manure applications are generally 
not allowed in the winter or on soils testing 
extremely high in P unless the field is beyond 
300 feet from lakes and streams and additional 
practices are installed to reduce P movement. 
In these situations, the MN P Index can be 
used to demonstrate that P loss risk is low. 
For more details about use of the MN P Index 
in these contexts, see the MPCA 7020 Rule, 
the General National Pollutant Discharge 
Elimination System (NPDES) Permit (the 
permit required for large feedlots), and the 
NRCS 590 Standard.

Watershed and Total Maximum 
Daily Load (TMDL) planning

Phosphorus loss risk assessment for a 
watershed involves two levels of effort. The 
first level is an assessment of the use of good 
stewardship practices that keep P on cropland 

Statewide, agriculture is one of several sources 
of phosphorus to lakes and streams.
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and out of water. These include runoff and 
erosion control practices and the use of 
University of Minnesota recommended nutrient 
management practices (soil testing, applying 
fertilizer and manure at agronomic rates, timely 
incorporation, and appropriate setbacks).  

The second level of assessment is identifying 
specific sites that may be the source of 
relatively higher amounts of P to a lake or 
stream. 

The MN P Index can be used to identify high 
risk sites and to determine the management 
changes that will be effective in reducing P loss 
from both high- and low-contributing sites. The 
MN P Index is a field-scale assessment tool, 
so watershed-scale inputs should not be used 
and Index results should not be summed across 
a watershed. It should be used in tandem with 
other measurements and models that assess P 
loss for the whole watershed. The MN P Index 
can be used in either of the two ways described 
below to determine the relative impact of 
various fields and practices on P delivery 
within a small watershed. 

Method 1: Field-based assessment
Step 1. Choose sites by using the Rapid 
Phosphorus Index (see page 10) to identify the 
low risk fields. 

Step 2. Use the MN P Index computer program 
to calculate P loss risk for the remaining fields 
across the watershed. 

Step 3. Examine the sites with high P loss risk. 
What proportion of the total sites have elevated 
risk? What factors are causing the higher risk? 

Step 4. Test proposed solutions. For example, 
rerun all the scenarios assuming that a specific 
best management practice was adopted. Would 
there be significantly fewer high-risk sites?

Step 5. Monitor changes in the number of 
high-risk sites over time.

Method 2: Sensitivity assessment
Step 1. Consider the variety of landscapes 
and cropping systems in the watershed. 
For each input to the MN P Index program 
define a range of attributes that represents the 
watershed. For example, there may be two or 
three major types of soils and landscapes, a few 
crop rotations, two main tillage systems, and a 
couple of manure and fertilizer practices.

Step 2. Run the MN P Index program on 
scenarios using the defined input ranges.

Step 3. Examine results by using the Export 
scenario data function in the File menu. Which 
scenarios have the highest P Index? What 
factors or combinations of factors are most 
important in determining P loss risk in this 
watershed? For example, perhaps moderate 
manure applications are only a problem on one 
landscape type. 

Step 4. Target the factors identified in 
Step 3 during data collection, monitoring, and 
education.

 
The MN P Index is 
a field scale tool. 
To analyze P loss 
risk from larger 
areas, analyze 
results from many 
fields within the 
watershed or farm.

What is “high risk”?

Generally, a site with a MN P Index value over 
4 has a high risk of P loss. Users may set a 
different threshold depending on their objective 
and the sensitivity of the receiving water. A 
threshold of 2 or 3 may be appropriate if a lake 
or stream is highly sensitive to P or if watershed 
planners aim to eliminate most all P inputs.
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Education

The MN P Index can be used to help explain 
the movement of phosphorus across the 
landscape and to illustrate the effect of 
various management practices. Here are some 
examples of educational uses.

•	 Run scenarios in the MN P Index program 
with an individual or group of land managers. 
Allow them to choose the management inputs. 
Show how the changes do or do not affect the P 
loss risk estimate. 

•	 Use the Reports function in the program 
to create graphs comparing the effect of 
alternative management practices for your local 
soils and cropping systems. Illustrate the effect 
of the interaction of multiple P loss risk factors. 

•	 Use diagrams of the MN P Index model to 
explain sources and transport of phosphorus.

Using the MN P Index 
Computer Program
The basic steps of running the program are 
shown below. Consult the user’s guide or 
online help for full instructions.

Gathering the inputs

Like any model, getting good results requires 
good inputs. A Data Collection Sheet is 
available at http://www.mnpi.umn.edu. 
Completing this form ensures you have all the 
information needed to run the MN P Index. 
Two important inputs are the distance to water 
and the description of the field slope.

Distance to nearest surface water
The user must decide what is the nearest 
body of water where P enrichment could be 
a problem. Generally, the nearest permanent 
stream, lake, or wetland is the primary water 
quality concern. In addition, any drainage ditch 

or other watercourse should be considered the 
nearest surface water if it is wet most of the 
year. In other words, if all of the phosphorus 
reaching a watercourse is likely to travel to a 
lake or stream, then that watercourse can be 
considered the “nearest water” for purposes of 
estimating P loss risk. If there is no concern 
about the water quality in a closed depression 
(i.e., water with no connection to other surface 
water), then it does not need to be considered 
the “nearest surface water.” Although some 
consider surface tile inlets a direct conduit to 
surface water, inlets should not be used as the 
“nearest surface water” in the MN P Index. 
Instead, indicate the presence of depressions 
with inlets. Due to their different method of P 
delivery, the program accounts for inlets and 
overland runoff separately.

Slope length and gradient
Erosion is an important cause of phosphorus 
loss, so a good erosion estimate is critical to 

Running the Program

1.  Download and install the program from 
http://www.mnpi.umn.edu. A user’s guide is also 
available there.

2.  When you start the program the first time, a 
“Quickstart Guide” will open to show the basics of 
the program.

3.  Select “New” from the File menu to create a 
new field.

4.  Double-click on the newly created field to 
open the Editor Window. Enter information 
about the site, the crop rotation, and tillage and 
manure management practices. Online help is 
available by pressing F1 or using the Help menu.

5.  On the last page of the Editor Window (the 
Yearly Data and Results tab), decide how many 
years to evaluate. If there are heavy manure 
applications, run an evaluation for as many as 20 
years to learn whether P loss risk increases as 
soil P levels build up. 

6.  View the P loss risk index results on the last 
page of the Editor Window. 
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generating a good P loss risk estimate. The MN 
P Index program uses the Revised Universal 
Soil Loss Equation 2 (RUSLE2) model to 
estimate erosion. An important input into 
RUSLE2 is the description of a cross-section of 
a slope in the field.

Estimates of erosion and P loss risk represent 
the whole field, yet only a single runoff path 
in the field is used to estimate erosion. This is 
appropriate because sediment and phosphorus 
are not lost evenly from all parts of a field, but 
come from a few critical source areas called 
the “most limiting areas of significant extent” 
(Minnesota NRCS, 2004). These are the 
areas of the field that most limit management 
because they have the greatest risk of erosion. 
Characterization and treatment of the field 
should focus on those critical areas, which are 

generally the areas with the steepest slope. 
“Of significant extent” means that the “most 
limiting area” selected should represent the 
characteristics of at least 20% of the field.

After identifying the “most limiting area of 
significant extent,” determine the soil type(s) 
and define the length and percent of slope(s) 
for this area. The slope length begins where 
overland flow originates and the slope ends 
where concentrated flow begins (i.e., the 
location where sides of a hillslope intersect to 
collect overland flow in defined channels, such 
as grassed waterways or gullies). This hillside 
may contain several slope segments, such as 
a gentle gradient near the top of the hill, a 
steeper side slope, and then a gentler toe slope. 
Estimate the length and gradient of each slope 
segment, or determine a typical slope gradient 
and length for the soil type. Typical slope 
information is available from your local NRCS 
Service Center (see Resources).

People familiar with RUSLE2 should note 
that the MN P Index uses the sediment 
delivery value, not the soil loss value. Both 
are estimates of erosion. Soil loss is a measure 
of soil movement within the field and is 
used for conservation planning. Sediment 
delivery is a measure of the soil delivered 
to the edge of the field or to the end of the 
defined runoff pathway. Sediment delivery 
may be less than soil loss if a toe slope is 
included where some of the soil is deposited. 

Table 2: Interpreting MN P Index Results

Total  
P Index

Risk Rating Recommended Response

0 to 1 Very Low Risk No management changes are recommended.

1 to 2 Low Risk Minor management changes are recommended.

2 to 4 Medium Risk Small improvements in management may be needed to lower P loss risk. Avoid 
practices that increase P loss risk.

4 to 6 High Risk Moderate improvements in management are recommended.

>6 Very High Risk Multiple and possibly large improvements in management practices recommended.

Identifying a critical slope is an important step in 
generating a good erosion estimate and a good 
P Index estimate.
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This is why it is sometimes important in the 
MN P Index to model a complex slope with 
multiple sequential slopes in the defined runoff 
pathway. RUSLE2 sediment-delivery numbers 
from the MN P Index should not be used for 
conservation planning because they 1) may be 
lower than soil loss values when a complex 
slope is used in the MN P Index, or 2) may be 
higher than values generated in the RUSLE2 
program because the MN P Index simplifies the 
inputs to RUSLE2.

Interpreting results

What the numbers mean
The results of the MN P Index are an estimate 
of the relative risk of a field being a source 
of phosphorus pollution to a nearby body of 
water. They are not quantitative estimates 
of P delivery although they correlate with 
P delivery. Low, medium, and high risk can 
be defined as shown in Table 2, but the user 
may adjust these depending on objectives and 
sensitivity of the receiving water. 

Management recommendations
In addition to the total result, note which 
pathway (erosion, rainfall runoff, or snowmelt) 
contributes most to P loss risk. This will allow 
you to identify which management practices 
will be effective at reducing the risk (Fig.2).

To reduce risk of sediment-bound P losses: 
Decrease erosion by reducing tillage and 
increasing crop residue cover. Add sediment 
traps such as buffer strips, and reduce or 
prevent high soil test P levels.

To reduce risk of soluble P losses in rainfall 
runoff: Decrease runoff by increasing surface 
cover, increasing infiltration, and by growing 
forages and other permanent vegetation. 
Reduce manure application rates. Incorporate 
or inject all manure and fertilizer, and reduce or 
prevent high soil test P levels.

To reduce risk of snowmelt runoff P losses: 
Eliminate application of manure on frozen 
ground. Leave soil surface rough in the fall and 
till across the slope rather than up and down. 
Although P lost in snowmelt can be reduced by 

Figure 2: Inferring Causes of P Loss Risk

This graph shows P Index results for three fields. Explanations for high risk can be inferred by noting which P loss 
pathway is dominant. For example, Field 1 has a moderate P loss risk with most of the risk coming from sediment 
bound P. This suggests high erosion rates. Field 2 has high P loss risk associated with snowmelt losses. The field 
may be in a high snowfall region and receiving winter manure applications. P loss risk in Field 3 is due to high 
runoff losses. Surface fertilizer or manure applications and rainfall runoff may be high.

0 2 4 6

Field 1

Field 2

Field 3

MN P Index P Loss Risk Rating 

Sediment bound P      Runoff Soluble P      Snowmelt P
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more aggressive fall tillage, burying most of 
the crop residue is not recommended because 
residue is needed after planting to prevent 
erosion and P loss by the other two pathways.

After identifying a suitable management 
change, use the MN P Index program to test the 
effect of the management change on P loss risk.

Limitations of the MN P Index
The MN P Index does not account for non-
agricultural P losses, losses due to leaching, or 
losses due to gully or wind erosion. Leaching 
losses are normally insignificant, but may be 
a concern on coarse, irrigated soils where soil 
test P or P applications are very high or on 
fractured soils with preferential flow channels 
that minimize the interaction of water with soil. 

MN P Index results are correlated with P 
delivery but do not indicate the absolute 
amount of P that will be delivered to surface 
water. The relative risk ratings support 
decisions about whether a management change 
will have a substantial impact on reducing P 
losses. Risk ratings, however, do not allow for 
direct comparisons to other sources of P such 
as municipal waste discharge.

The MN P Index does not indicate changes 
in surface water quality because it does not 
consider sensitivity of the receiving waters, 
sources of P such as municipal and commercial 
waste, or P-rich sediments previously deposited 
in the lake or stream. 

The MN P Index does not consider the 
environmental costs of P delivery to surface 
waters nor the cost of adoption of different 
practices to reduce P losses from specific fields.

The Rapid Phosphorus Index
The MN P Index is easy to learn and use 
but requires a modest amount of time for 
collecting input data. When many fields need 
to be analyzed, the Rapid Phosphorus Index 
(RPI) (Fig. 3) can be used as a screening tool 
to quickly eliminate the lowest-risk sites or 
to focus on the highest-risk sites where the 
MN P Index will be applied. The RPI is a set 
of indicators and thresholds based on the MN 
P Index. It will identify high risk attributable 
to major risk factors but will not assess 
interactions among multiple factors. 

The inputs needed for the RPI include 
estimates of manure and fertilizer application 
rates, P application method, soil test P, erosion 
rates, distance to water, and quality of soil 
drainage. The RPI is three separate tools of 
varying sensitivity. The high-sensitivity version 
is used to eliminate only the lowest-risk sites. 
The low-sensitivity version is used to eliminate 
all but the very highest-risk sites.

Summary
Farmland can be a significant source of the 
phosphorus that causes excess algae growth in 
lakes and streams. This publication explains 
when and how to assess the risk of phosphorus 
loss from cropland using the MN P Index. 

Runoff of phosphorus from uplands into 
surface water can be influenced by many 
factors, especially erosion rates, manure 
application rates, soil test P levels, and distance 
between the field and the surface water. 
These major indicators can be used alone to 
roughly identify sites that are likely to lose 
phosphorus. The MN P Index is a user-friendly 
model that allows users to analyze the effect 
of interactions among the major factors as 
well as other considerations related to climate, 
landscape, and management practices. The MN 
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P Index can be used to estimate which sites 
are most likely to lose phosphorus and what 
changes in management practices would be 
effective in reducing risk.

The MN P Index is a process-based model of 
three pathways of P transport: erosion, runoff, 
and snowmelt. Noting which pathway is 
important in a particular situation gives users 

information about what management changes 
would be most effective in reducing losses. 
The results from the MN P Index represent the 
relative risk of P loss. For example, a doubling 
of the risk value suggests P delivery is likely to 
double given the same set of weather events. 
The MN P Index results should not be used to 
quantify actual P delivery, but can be used to 

Figure 3: The Rapid Phosphorus Index

Choose one of the three tools below. Check the appropriate box if a criteria is met. If any one of the criteria are 
met in any year of the rotation, then the full MN P Index should be run on the field to calculate a more reliable 
estimate of P loss risk. (Available on-line at http://www.mnpi.umn.edu/)

High sensitivity screening tool

If the site meets any of these criteria, the Total P Index may be greater than 2.

  Any amount of manure or fertilizer unincorporated

  More than 100 lbs P2O5/ac/yr manure and/or fertilizer incorporated

  Soil test P is >100 ppm (Olsen) AND soil loss is  >3 t/ac/yr

  Soil test P is >100 ppm (Olsen) AND infiltration is slow (i.e., Hydrologic Soil Group is C or D, or soil is  
clay or clay loam and without artificial drainage) 

  Erosion is >8 t/ac/yr

  Distance to water is <100 ft and erosion is >5 t/ac/yr

  Distance to water is <10 ft and erosion is >3 t/ac/yr

Moderate sensitivity screening tool

If the site meets any of these criteria, or two of the criteria in the high sensitivity tool, the Total P Index may be 
greater than 4.

  More than 100 lbs P2O5/ac/yr manure and/or fertilizer unincorporated

  More than 200 lbs P2O5/ac/yr manure and/or fertilizer incorporated

  Soil test P is >100 ppm (Olsen) AND soil loss is  >3 t/ac/yr

  Erosion is >10 t/ac/yr

  Distance to water is <100 ft AND erosion is >6 t/ac/yr

  Distance to water is <10 ft AND erosion is >4 t/ac/yr

Low sensitivity screening tool

If the site meets any of these criteria, or two of the criteria in the moderate sensitivity tool, the Total P Index may 
be greater than 6.

  More than 200 lbs P2O5/ac/yr manure and/or fertilizer unincorporated

  More than 200 lbs P2O5/ac/yr manure and/or fertilizer incorporated AND erosion is more than 4 t/ac/yr

  Erosion is >10 t/ac/yr

  Distance to water is <10 ft AND erosion is >6 t/ac/yr
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compare the relative delivery from different 
management scenarios. The MN P Index is a 
model of transport of P to surface water and 
thus does not predict the effect of the P on 
water quality once it enters the stream or lake.

The MN P Index analyzes P loss risk at a field 
scale. However, farmers, conservationists, and 
watershed planners manage land at a farm scale 
or at a small watershed scale. The MN P Index 
can be used at these larger scales by comparing 
MN P Index results for all the fields in a farm 
or watershed, or by examining scenarios that 
represent the potential conditions in the farm or 
watershed. 

The quality and usefulness of the results of the 
MN P Index depend on the quality of inputs. 
For example, the slope used to estimate erosion 
and the identification of distance to surface 
water significantly impact the MN P Index 
result.

The Rapid Phosphorus Index (RPI) is a set of 
indicators and thresholds based on the MN P 
Index. It is less powerful but quicker to use 
than the MN P Index. It can be used to reduce 
the number of sites by eliminating the lowest-
risk sites or focusing on the highest-risk sites 
where the MN P Index will be applied. The 
RPI is based on the MN P Index but does not 
analyze interactions among multiple factors.
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